
Welcome to SAi Flexi 12 

The Flexi product group contains some of the world’s advanced tools for print production and sign 

making software.  We have added many new features based on your feedback. 

Operating Systems Supported 
• Windows 10 
• Windows 8 32-bit (x86) or 64-bit (x64) processor 
• Windows 8 Pro 32-bit (x86) or 64-bit (x64) processor 
• Windows 8 Enterprise (x86) or 64-bit (x64) processor 
• Windows 7 Home Premium 32-bit (x86) or 64-bit (x64) processor 
• Windows 7 Professional 32-bit (x86) or 64-bit (x64) processor 
• Windows 7 Ultimate 32-bit (x86) or 64-bit (x64) processor 
Installing on a Mac using parallels or bootcamp is not recommended and not supported. 

 

SAi Flexi 12 (SP5) 
Build 2878 
Oct 17, 2018 

 

Bug Fixes 

 Fixed issue of Job Properties window opening on disconnected monitor, 9634 and 9517 

 Fixed issue with Open Type Font not showing all of the font styles, 9560 

 Fixed issue of Roland VG mapping White to Cyan channel, 9556  

 Fixed issue of Fotoba marks on tilled job printing inside the image, 9501 

 SAi Store link removed from Help menu, 9472 

 Fixed margins issue with Mutoh VC registration marks, 9442 

 Fixed issue when tiff files colors are mixed, 9441 

 Fixed issue of Custom Color Swatch with change not applying correctly, 9440 

 Fixed the issue of Job Status frozen at 99%, 9424 

 Fixed Aristo Driver missing Contour name check box, 9410 

 Fixed issue of objects becoming ungrouped after using View filter, 9381 

 Fixed issue of text displaying in v12 from v8 files, 9373 

 Fixed issue of masked layer disappearing when file is exported as png, 9355 

 Fixed issue of v8 file with large mask running slow in v12, 9347 

 Fixed zooming issue with object is on large coordinates, 9339  

 Fixed issue of crop marks not saving correctly with preset, 9323 

 Fixed issue of not applying Contour Cut to thine stroke in ai file, 9296 

 Fixed issue of Fotoba marks prints inside the image when Skip Vertical mark is selected, 9276 

 Fixed issue of PDF boundaries to crop box not applied when file added to PM, 9213 

 Fixed issue of EPS page boundaries not applied when decimal symbol is “,”, 9212 

 Fixed issue with bad cut files for SummaFlex, 9204 

 Fixed issue error with compounding winding fill, 9193 

 Fixed issue with AI file with huge soft mask, 9192Here  



 Fixed issue with Graphtec command language not recognized if cutter set to Auto, 8387 

 Corrected Italian translation for break apart and true nesting, 9186 

 Fixed Ink estimation for Step and Repeat job, 9633 

 Fixed issue when object with large mask cannot be selected by dragging, 9658, 9191 

 Fixed issue with grommet preview, 9277 

 Fixed Linearization Target and Advanced Barbieri settings in Chinese language, 9352 

 Fixed issue of profiler target file not deleted if DJP set to hold, 9646 

 Fixed Chinese translation in Output Size Compensation, 9850 

 Fixed printing 6 color band on HP L 26500, 8695 

 Fixed issue of importing compound object with CutContour and solid fill, 9631 

 Fixed issue of printing stopped after 27 m on HPL 360, 9425 

 Fixed Issue with Braille translation, 9563 

 Fixed issue with .ai file with large linear gradient crashing, 9187 

 Fixed issue with two-byte character in XML file name for Epson, 9529 

 Fixed issue wit printing to Epson desktop printer, 9561 

 Fixed issue with PM not supporting index colors in tiff, 9579 

 Fixed issue with spot channel mapping for GCC JF- UV, 9614 

 Fixed an issue with HP L xxx crashing and not reading media info, 9387 

 Fixed issue with Fotoba marks shifting, 9655 

 Fixed an issue when loading bug number of files to PM some files with have wrong status, 9478 

 

Enhancements 

 Summa OPOS XY line prints as default 3mm, 9532 

 Summa Barcode and OPOS XY line aligned, 9532 

 HP Latex cutter OPOS barcode  registration marks added to Flexi designer, 9862 

 Help Topics in English language version to point at Flexi Knowledge Base website, 9472 

 Adding 2.5% increment chart for Linearization, 9294 

 Dual roll printing with Summa OPOS marks, 9418 

 Summa Barcode Server to be on by default in branded versions, 9377 

 On startup program will check if pervious windows position on monitors is still available, if not 

all windows will open on the main monitor, 9634 and 9571 

 Multipage PDF file with Contour Cut to generate cut file for each page, 9293 

 Send to Dual RVW is enabled in Subscription by default, 9644 

 Improved handling of single channel images with overprint, 9211 

 Option to save default settings for Braille tool, 9391 

New Features for both Perpetual licenses and Subscriptions  

 Mathew Paints color chart added to Flexi Swatches, 9745 

 Support for Summa OPOS XY2 marks, 9535 

 Send to VirtualSIGN beta, 9595 

 Multi-sample measurement for i1, 9524 

 Enhanced option for PNG export, make transparent, interlaced, different resolution, 8595 



New Features for Subscriptions  

 Editing of winding fill, 9193, 9192 

 

 
 
 
New Printer Drivers 

 AC-COLOR; AC-COLOR ToshibaCF3; AC-COLOR ToshibaCF4 

 ApexJet: ApexJet XP600 

 Avery Dennison: TrafficJet 1638X 

 BC PRINTER; BC-EP-9060-4C; BC-EP-9060-6C; BC-EP-9012-4C; BC-EP-9012-6C; BC-EP-2513-4C; 

BC-EP-2513-6C; BC-G5-2513 

 Bihong; BH-DailyJet; BH-MiniJet; BH-Q-Jet 

 CaiYi: CaiYi 2513; CaiYi DD3200; CaiYi JC3200    

 Canon: imagePROGRAF PRO-6000; imagePROGRAF PRO-500; imagePROGRAF PRO-520; 

imagePROGRAF PRO-540S; imagePROGRAF PRO-560S; imagePROGRAF PRO-540; 

imagePROGRAF PRO-560; imagePROGRAF TX-2000; imagePROGRAF TX-3000; 

imagePROGRAF TX-4000; imagePROGRAF TX-5200; imagePROGRAF TX-5300; 

imagePROGRAF TX-5400 

 CF: CF-Xaar Series 

 CoStraight: CoStraight RY 2513; CoStraight RY; CoStraight RY 3216; CoStraight RY 3300R; 

CoStraight BY 2513; CoStraight BY 2036 

 Delone: Delone-KM-512i-14PL; Delone-KM-512i-14PL; Delone-CE4UV; Delone-EP5113   

 Docan; Docan-TX 

 EGERI: EGERI-G5series-A; EGERI-G5series-B 

 Ejet : Ejet_EP_TX800_XHS 

 Eyecolor; Eyecolor-GEN5-2513-HS; Eyecolor-2000D-HS; Eyecolor-1680S-HS Eyecolor-

2000D-S-HS; Eyecolor-3200UV-HS; Eyecolor-GEN5-2513-RL  

 FEDAR: FEDAR-TC1932; FEDAR-FD1900; FEDAR-FD6194E; FEDAR-FD5193E 

 File: HP Tiff Workflow  

 FLY PLUS: FP-DX5 FP-DX5-Dual; FP-DX7-A FP-DX7-A-Dual; FP-DX7-B FP-DX7-B-Dual 

 Fortune: YF-Xaar1201  

 Gethray: Gethray-BYHX-A-KM1024i-30PL-720 

 GongZheng: GongZheng GZW2513; GongZheng GZW6090TX 

 GZBK: GZBK-DX5; GZBK-DX7; GZBK-DX10; GZBK-DX5113; GZBK-X5; GZBK-UV-DX5; GZBK-

UV-DX7; GZBK-UV-DX10; GZBK-UV-X5 

 HP: DesignJet Z6810 42in; DesignJet Z6610 60in; HP Latex R1000 HP; Latex R2000; 

PageWide XL 6000;PageWide XL 5100 

 HONGYING : HONGYING-XP600 



 Iconteck: TW-2513GU-G5; TW-1604-DX5; TW-1808-DX5; TW-1604X-XP600; TW-3216-

XP600; TW-3308HG-508GS; TW-3308MG-508GS; TW-3308XG-508GS; TW-2513GU-

SPT1024GS  

 INKSEA: INKSEA-Rioch G5 

 JSW: JSW QR3200G; JSW F2513G 

 LINK: LINK-RICOH-GEN5 

 MACAN UV: MU-3300-XP600 

 MACAN: MACAN-M-1300; MACAN-M-1300-5113; MACAN-D-1600-DX5; MACAN-D-

1600-5113; MACAN-C-1600-DX5; MACAN-C-1600-5113  

 MGW: MGW-Spectra-PQ512-15-2HC-4C; MGW-Spectra-PQ512-15-2HX-4C; MGW-

Spectra-PQ512-15-4C; MGW-Spectra-PQ512-35-4C; MGW-PQ512UV-4C; MGW-Spectra-

PQ512UV-6C; MGW-Spectra-PQ512UV-8C; MGW-KM512UV-14-4C; MGW-KM512UV-14-

6C; MGW-KM512UV-14-8C; MGW-KM024UV-14-4C; MGW-KM024UV-14-6C MGW-

KM024UV-14-8C; MGW-Xaar-P382UV-15-4;C MGW-Xaar-P382UV-15-6C; MGW-Xaar-

P382UV-15-8C; MGW-Xaar-P382-35-4C; MGW-Xaar-P382-60-4C; MGW-Xaar-P382-15-

4C; MGW-Xaar-P382-15-6C; MGW-Xaar-126-4C MGW-Xaar-126-6C; MGW-Xaar-128-4C 

MGW-Xaar-128-6C; MGW-Xaar-128+-4C MGW-Xaar-128+-6c; MGW-Spectra-PQ512-15-

4C; MGW-Spectra-PQ512-35-4C; MGW-Spectra-PQ512UV-4C; MGW-Spectra-PQ512UV-

6C; MGW-Spectra-PQ512UV-8C; MGW-K512-42-4C; MGW-K512-42-6C; MGW-K512-14-

4C; MGW-K512-14-6C; MGW-K256-42-4C; MGW-K256-42-6C; MGW-K256-14-4C MGW-

K256-14-6C; MGW-Xaar-382-4C; MGW-Xaar-128E-4C; MGW-Xaar-128+E-4C MGW-Xaar-

382D4-4C; MGW-KM1024-14-4C; MGW-KM1024-14-6C; MGW-KM1024-42-4C; MGW-

KM1024-42-6C; MGW-EPDX5; MGW-EPDX5-BYHX; MGW-RICOH-GEN4-4C; MGW-RICOH-

GEN4-6C; MGW-RICOH-GEN4-8C; MGW-RICOH-GEN5-4C; MGW-RICOH-GEN5-6C; MGW-

RICOH-GEN5-8C; MGW-KM1024ISE; MGW-KM512I-30PL-4C; MGW-KM512I-30PL-6C 

 Mimaki: UCJV-300-160; UCJV-150-160; UCJV300-160 CMYKLcLmW; UCJV300-160 CMYK; 

UJF-3042MkII; UJF-6042MkII; UJF-3042MkII; EX JFX200-2531; GP-604; GP-604D; UJF-

3042FX ;UJF-3042HG; UJF-3042A3FX; UJF-3042A3HG; Tiger-1800B 

 Mutoh: VJ-1638UR; VJ-2638WX, VJ 1627MH, VJ 628MP, PJ 2508UF 

 Nocai: Nocai-A4+PhotoPinter 

 QSS GREEN: QSS GREEN 12C 

 REVOTECH: REVOTECH-KHE-4W4V; REVOTECH-KHE-3W6C3V 

 Ricoh: RollToRoll_v1_1; Ricoh Pro L5130; Ricoh Pro L5160  

 Skycolor: SUNIKA-H1 DX5; SKYCOLOR-320TS; DX5 SKYCOLOR-6160S; DX5 SKYCOLOR-

6180TS DX5; SKYCOLOR-4180TS DX5; SKYCOLOR-4180UV DX5; SKYCOLOR-6160UV DX5; 

SUNIKA-H1 WF5113; SKYCOLOR-320TS; WF5113 SKYCOLOR-6160S; WF5113 SKYCOLOR-

4180TS; WF5113 SKYCOLOR-TR4180; WF5113 CLOUDJET-F1-WF511; STORMJET-7160 

DX5; STORMJET-7160 WF5113; STORMJET-TR3180; WF5113 CLOUDJET-F1-DX5; 

CLOUDJET-F1800 DX5; STORMJET-7160 DX5: STORMJET-7180TS DX5; STORMJET-3180TS 

DX5; 



 SLJET: SLJET-GEN5; SLJET-GH2220; SLJET-EPSON 

 Grando: GRANDO GDK-512i  

 SunThinks: SunThinks R-GH2220 

 TechJET PRO: Pro TechJET Pro 6050KF 

 Techjet: Techjet RY 2513 Techjet RY 2036; Techjet RY 3216; Techjet RY 3300R; Techjet 

BY 2513; Techjet BY 2036 

 VANYE: VANYE-GEN5-UV; VANYE-EPSON-UV; VANYE-EPSON-UV-SY  

 VenusLF: VenusLF GHS Series 

 Xuli: XL-Xaar-1201A-; XL-Xaar-1201B-UV; XL-KM-512I; XL-Xaar-1201C-UV; XL-Xaar-1201C 

 YAGENGFU: YGF-E6080UV  

 Yaselan: YSL-C-G5UV; YSL-C-CSG5UV  

 YOUZE: SYZ-UV-G2513: SYZ-UV-G2518: SYZ-UV-G2030: SYZ-UV-G2530  

 YOUZE: SYZ-UV-G2513; SYZ-UV-G2518; SYZ-UV-G2030; SYZ-UV-G2530  

    

New Cutter Drivers 

 GCC: RX II-61-CR 

 Graphtec: CE LITE-50 

 Graphtec GP-GL: CE LITE-50 

 Helitin: HT-FP1209 

 JINKA: MultiSeg-AML; JK-ML 

 Mimaki: UCJV300-160 CMYKLcLmW; UCJV300-160 CMYK; UCJV150-160; CF22-1225 

 Roland: GR-540-r90 

 Summa: D140RL; F SERIES (SummaFlex2) 

 TechJET Pro: TechJET Pro 6050KF 

 TOPT: G45-AML; G65-AML; G125-AML; G165-AML 

 TOTENW: T33Q-AML; T53Q-AML; T73Q-AML; T33SQ-AML; T53SQ-AML; T73SQ-AML; 
EST850Q-AML; EST1350Q-AML; EST1850Q-AML; EST850SQ-AML; EST1350SQ-AML; 
EST1850SQ-AML 

 Zund: S3 M-800 HPGL; S3 M-1200 HPGL; S3 M-1600 HPGL; S3 L-1200 HPGL; S3 L-1600 
HPGL; S3 XL-1200 HPGL  
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Bug Fixes 

 Fixed temporary files not being deleted after closing PM 

 Fixed PDF exports with border by default 

 Fixed InDesign files with spot colors not opening correctly 

 Fixed LAB values conversion not rounded properly 

 Fixed Open Dialog Box opens behind design window 

 Fixed Summa display values change to mm 

 Fixed Incomplete rendering of thin lines 

 Fixed TIFF files with same name not printing correctly 

 Fixed Epson density not applied in profile 

 Fixed option manually changing tile size  

 Fixed Error out of memory while cropping image 

 Fixed Ink Estimation for TraficJet 

 Fixed PM not respecting overprint command 

 Fixed applying bleed to JPG in finishing tool cropping file 

 Epson SC 80600 printing in 8 bit mode 

 Fixed various issue with reg marks on dual roll printing 

 Fixed issue when re-ripping nested job with different resolution 

 Fixed file name issue when cut file sent to Summa Cut Center 

 Fixed cut path direction 

 QR code size when auto serializing 

 Fixed Job Nesting option causing JP layout issue. 

 Fixed windows scaling issue with mouse position and fill color indicator 

 Fixed JPG files cropped after applying bleed  

 Fixed unable to open FS file when converting fonts to paths 

 Fixed inverted Graphtec type 2 marks not printing correctly 

 Fixed slow loading FS files with soft shadow effect.  

 Fixed issue when nested jobs is re-ripped with a different resolution and is not sent to the 

machine 

 Fixed dragging color swatch. Color swatch does not display on the coordinates of the mouse. 

Scale factor issue 

 Fixed Production Manager changes layout when job has crop marks and Job Nesting is checked 

 Fixed QR code size not applied correctly after auto-serialization with variable data 

 Fixed cut path direction correct in the preview when actually cutting direction 

 Fixed Canon 4000s printer driver with Multifunctional Roll System  

 Fixed HP Z5200 unable to print: Data format error when sending job 

 Fixed miscellaneous PDF import issues 

 Fixed punctuation not working in Flexi for specific font.  

 Fixed opening or importing Flexi files asking to save right away 

 Fixed jobs processing job with spot colors although spot color mapping is unchecked 

 Fixed text positioning (kerning) is not correct when loading an old file in new version 

 Fixed Mimaki Printer USB ports changing 



 Fixed printing to Production Manager using Desktop Driver doesn't print text 

 Fixed various issues printing to desktop printer 

 Fixed Titan 3 Arms Plus New Registration Marks not printing correctly 

 Fixed make transparent tool not working correctly 

 Fixed Kala KY marks: changing the top and bottom margin settings causes the marks to be 

printed incorrectly 

 Fixed Kala XY marks: multi-copy & disproportionately scaling images will cause an upward shift 

of the marks after each copy 

 Fixed preset setting for driver option tab are not loaded correctly from RIP and Print window 

 Fixed cut job will not go to Ioline Supper 88 plotter 

 Fixed presets not applied correctly when adding job to Production Manager 

 Fixed poll size on Roland printer  

 Fixed recognition issue with cut lines in Production Manager from 3rd-party applications 

 Fixed all copies cut, then weed border issue 

 Fixed Graphtec FC8600 cutter workflow problem when using 2 strategies 

 Fixed EPS export for LAB colors 

 Fixed a RIP error printing tile maps in European locales 

 Fixed issue with printing two large tiff files with same name one after the other 

 Fixed Graphtec registration marks preview when toggling between negative and ‘regular” marks 

 Fixed cursor disappearing over color mixer slide bar 

 Fixed Mimaki JFX200-2513 error 201 

Enhancements 

 Added X-Rite Eye-One IO to device list in the Color Profiling Wizard 

 Improvement for SAi multi segment marks 

 Improvement for cutting option such as pausing between colors when the job is sent directly 

from Production Manager 
 Updated color swatch libraries 

 Improved Templates feature to allow drag borders for the job info items and wrap the text with 

that border 

 Added support for display of Cut/Plot and RIP and Print dialogs on low resolution monitors, by 

adding scroll bars to the pages 

New Features for both Perpetual licenses and Subscriptions  

 HP and Summa Barcode server 

 Added new orientation options to True Shape Nesting for print direction and gravity point 
 Added support of interlaced PNG files  

 Added sending to Roland VersaWorks Dual  

 
New Features for Subscriptions only 

 Added support for SVG files 
 Added support for single frame GIF images  



 
 
New Printer Drivers 

 Addtop: ADD-GEN5-7C-R, ADD-GEN5-5C-R, ADD-F66-5C-H, ADD-F66-7C-H 

 AFRD: AFRD-UV3624E, ADD-SE-4S--S-8CP, ADD-SE-4S--W-8C, ADD-GEN5-5C-B, ADD-

GEN5-7C-B 

 AM.CO.ZA: FastCOLOUR GT-HS-DX5, FastCOLOUR GT-HS-W5113, FastCOLOUR GT-HS-

XP600 

 ANS: ANS-DX5-PE, ANS-DX5-BYHX, ANS-KM512-14PL, ANS-KM512-42PL, ANS-MK1024-

14PL, ANS-KM1024-42PL, ANS-KM512i-30PL, ANS-KM1024-14PL-UV 

 Atom: Atom-EP1082, Atom-EP3202, AtomK512i 

 AW: AW-DX5 

 Bass Bowei: Bass Bowei-1610UV-RICOH-GEN5, Bass Bowei-2512UV-RICOH-GEN5, Bass 

Bowei-2513UV-RICOH-GEN5, Bass Bowei-2030UV-RICOH-GEN5, Bass Bowei-1612UV-

RICOH-GEN5 

 BOSSRON: WT-1802F-DX5113, WT-1325UV 

 CBF: CBF KM-1024i MHE, CBF KM-1024i SHE, CBF KM-512i, CBF Gen5 UV, CBF SG1024 

CBF KM-1024i 30PL, CBF PQ-512, CBF Gen5 UV-7C 

 CF: CF-G5 Series 

 Cosine: Incortex SPD-4C 

 CrystalJet: CJ-TOCE4-UV, CJ-EpsonII, CJ-Ricoh5UV-WV, CJ-EpsonI 

 CubeMark: CM-16-7C 

 Dacen: DACEN DC2513, DACEN DC1510, DACEN DC2030, DACEN GC2513, DACEN 

GC1510, DACEN GC2030 

 Delone: Delone-KM-1024i-30PL 

 Digital Printer: TT-PC3200-4H, TT-GEN5-6H-WV, TT-AT-DX5-4C, TT-AT-DX5-4C-WV, TT-

HS-XP600-4C, TT-RY-GEN5-WV 

 DYSC: DYSC-1024SG 

 DYSS: DYSS-Apollo-8F 

 Ecotech: Ecotech-Taurus 

 EDSON: EDS-2513, EDS3020 

 Ejet: Ejet-J3200 Ejet_EP_5113_BYHX,Ejet_EP_5113_SY, Ejet_EP_5113_XHS, 

Ejet_EP_DX5_BYHX, Ejet_EP_DX5_SY, Ejet_EP_DX5_XHS, Ejet_RICOH_GN5_BYHX, 

Ejet_RICOH_GN5_GLH, Ejet_SG_1024_BYHX, Ejet_EP_DX5_2H_SY_UV 

 Epson: SC-B9000, SC-B9070, SC-B9080, SC-F9300, SC-F9370, SC-F9360, SC-F9330, SC-

F9340, SC-F9380, SC-F9350 

 FD.EEC: EEC  Printer 

 FeiDie: FD-TC1932 



 Fei Yeung Union: FY-2300TXD8, FY-2300TXF8, FY-3200ATE8, FY-3200SEA12, FY-

3200SEB12, FY-3200SEC8 

 Flora: Flora-Gen5 

 Forni: Forni-DX5-K, Forni-5113-K, Forni-BYHX-DX5-UV 

 FD.EEC 

 GCC: GCC JV-240UV, GCC MPC-240UV 

 Gethray: Gethray-UMC Gen5-2, Gethray-BYHX-A-KM1024i-30PL 

 Helitin: HT-P750-Water, HT-P750-Eco 

 HP: HP Latex 3600, HP Latex 3200, HP L115 

 HeXuan: HX-BYHX-512i 

 HL: HL-2613G5, HL-6000G5 

 HONGYING: HONGYING-1600H 

 Human Digital: HM-DP XAAR1201, HM-DP SG1024-25PL-2C, HM-DP 512i-6pl UV, HM-DP 

1024i-6pl UV,HM-DP GEN5 UV, HM-DP XAAR1201 UV, HM-DP 512i-6PL TEX, HM-DP 

1024i-6pl 2bit TEX, HM-DP 1024i-6pl 1bit TEX, HM-DP GEN5 TEX, HM-DP SG1024-25PL-

2C TEX, HM-DP SG1024-25PL TEX, HM-DP SG1024-10PL TEX 

 JADE: JADE-KM-512-14PL, JADE-KM-512-42PL, JADE-KM-1024-14PL, JADE-KM-1024-

42PL, JADE-KM-1024-14PL-UV, JADE-KM-1024-6PL, JADE-KM-1024i-13PL, JADE-KM-512i-

30PL, JADE-DX5-ECO, JADE-DX5-Water, JADE-DX5-UV, JADE-KM-512i-30PL-180, JADE-

Ricoh2220-3PL, JADE-GEN5-7PL-Water, JADE-GEN5-7PL-UV, JADE-DX7-ECO, JADE-DX7-

Water 

 JHF:JHF XJ3200, JHF KYOCERA 

 Keditec: Keditec-Keundo TX6 

 KingJet: KingJet-XAAR 1002-RY-16C, KingJet-XAAR 1002-SD-16C, KingJet-8Level-Test 

 LiYu :LY_PZR_KU_LED_4, LY_PZR_KU_LED_6, LY_PF_KT_4, LY_PF_KT_6, LY_KRJ_KT_4, 

LY_KRJ_KT_6, LY_KC_KY_4, LY_KC_KY_6, LY_PCT_KY_LED_4, LY_PCT_KY_LED_6, 

LY_PCT_KW_4, LY_PCT_KW_6, LY_KG253608_SG 

 LongKe, LongKe-6090-RICOH, LongKe-6090-GH2220 

 MACAN: MACAN-M-1600, MACAN-M-1800, MACAN-M-1900, MACAN-M-3300, MACAN-

M-1600-5113, MACAN-M-1800-5113, MACAN-M-1900-5113, MACAN-M-3300-5113, 

MACAN-M-1800TX, MACAN-M2200-5113, MACAN-M1802-DX5, MACAN-M1802-DX7, 

MACAN-M1802-5113 

 Micolor: MC-5800-VSD2, MC-5800-VSD3 

 Mutoh: VJ-1948WX, VJ-626UF, VJ-404GT, VJ-405GT 

 MyColor: MYCOLOR-UV-GD10, MYCOLOR-B5, MYCOLOR-BG5, MYCOLOR-G5, MYCOLOR-

G10, MYCOLOR-GX5 

 MyJet, MyJet-G5W, MyJet-G5WV 

 Nocai: Nocai-UV-GEN5, Nocai-UV0609-2017, Nocai-FZ0609-2017, Nocai-A4 plus 

 Oric: Oric WH-R-Gen5 

 PLAMAC: PLAMAC-SG1024 



 Polar: PL-2613G5, PL-6000G5, PL-Xaar-1201A, PL-Xaar-1201B 

 PrintPretty: Niprint LT18-DX5-150, Niprint P5S_1024v 

 Ricoh: Tiff, RICOH-Pro-T7210-4C, RICOH-Pro-T7210-5C, RICOH-Pro-T7210-6C, RICOH-

Pro-T7210-7C 

 Roland: VersaUV LEF-12i ECO-UV, VersaUV LEF-12i ECO-UV4, VersaUV LEF-200 ECO-UV 

CMYKGlossW,VersaUV LEF-200 ECO-UV CMYKPrimerW,VersaUV LEF-200 ECO-UV 

CMYKWW, VersaUV LEF-200 ECO-UV4 CMYKGlossW, VersaUV LEF-200 ECO-UV4 

CMYKPrimerW, VersaUV LEF-200 ECO-UV4 CMYKWW, VersaUV LEF-20 ECO-UV 

CMYKGlossW, VersaUV LEF-20 ECO-UV CMYKPrimerW, VersaUV LEF-20 ECO-UV 

CMYKWW, VersaUV LEF-20 ECO-UV4 CMYKGlossW, VersaUV LEF-20 ECO-UV4 

CMYKPrimerW, VersaUV LEF-20 ECO-UV4 CMYKWW 

 Ruituo: RT-3206P, RT-3208P, RT-3278K, RT-3278K, RT-3276P, RT-32712X, RT-3286E, RT-

3288X, RT-161LC, RT-1612LC, RT-3214AC 

  SaiTu: SaiTu-3200UV, SaiTu-3200, SaiTu-1024GS, SaiTu-Gen5, SaiTu-EP5113, SaiTu-

Gen5-2, SaiTu-XP600 

 SignStar, SignStar-GHF2513-4VN, SignStar-GBP3202E5E7, SignStar-GBP3208SK3, 

SignStar-GBP1802-1803WF, SignStar-Test, SignStar-SFP1601E5, SignStar-SFP1601E6, 

SignStar-SFP1601WF 

 SinoColor:Storm SJ-740C, Storm SJ-1260C, Storm SY-3208K, Storm SY-3204P 

 SinoPRINT: SP-1615EP, SP-2025EP, SP-2045EP, SP-3225EP, SP-3245EP,SP-1825F, SP-

2045F, SP-3245F, SP-1613P,SP-1823P, SP-2033P, SP-2043P, SP-1823F, SP-336UR, SP-

326UR, SP-GT7, SP-GTe, SP-1808TF, SP-1804TF, SP-UF5,SP-GT5,SP-246E, SP-526E,SP-

50EC,SP-75EC, SP-90EC, SP-160EC 

 SCG:GRANDO GDK-512i 

 StratoJet USA: Shark EFB-2512, Shark E72s 

 SunWin: JETWIN KM512I, JETWIN KM-1024, JETWIN EP-DX5BJ, JETWIN SG1024-10PL, 

ETWIN SG1024-25PL, JETWIN 5113 

 Taimes: Taimes-KM-512i-6PL, Taimes-GEN5-7PL-WV-4C, Taimes-GEN5-7PL-WV-6C, 

Taimes-Ricoh2220-3PL-WV-4C, Taimes-Ricoh2220-3PL-WV-6C, Taimes-KM-1024i-30PL, 

Taimes-CE4UV 

 TCJX:TCJX-G5 Series 

 Textalk: Textalk TS-1800, Textalk TS-3200 

 ThunderJet: ThunderJet 1602-EL 

 TianLong: TL-PQ512-4C, TL-PQ512-6C, TL-PQ512-8C 

 Titan: TT-PC3200-4H, TT-GEN5-6H-WV, TT-AT-DX5-4C, TT-AT-DX5-4C-WV, TT-HS-XP600-

4C, TT-RY-GEN5-WV 

 Wit-Color Digital: ULTRA Starfire-M-4C, ULTRA Starfire-M-6C-T, ULTRA Starfire-M-6C-F, 

ULTRA9100-HS 



 X-Roland, X-Roland-DX5DX7, X-Roland-W5113, X-Roland-DX5DX7-WV, X-Roland-GEN5-

4C-WV, X-Roland-GEN5-6C-WV, X-Roland-XP600-2HD, X-Roland-AT-DX5DX7, X-Roland-

AT-5113 

 Xkeda: XLF_PC1080_HS_3S 

 Xuli: XL-X6-6000G5,  XL-Xaar-1201A, XL-Xaar-1201B 

 Yaselan, YSL-D-G5UVCS, YSL-S-G5UV 

 Yinghe: Yinghe-DX5DX7, Yinghe-W5113, Yinghe-DX5DX7-WV, Yinghe-GEN5-4C-WV, 

Yinghe-GEN5-6C-WV, Yinghe-XP600-2HD, Yinghe-AT-DX5DX7, Yinghe-AT-5113 

 Yorkdeal: Yorkdeal-B-K1024-14PL, Yorkdeal-B-K1024-42PL, Yorkdeal-UMC-KM512i, 

Yorkdeal-UMC-XAAR382 

 YOUZE: SYZ-UV-G2530 

 YUEDA: YD-RICOH, YD-KYOCERA, YD-EPSON, YD-SG1024, YD-KONICA, YD-XAAR 

 ZT-Printer: ZT-4C-ICC 

 

 

New Cutter Drivers 

 Foison: MultiMark-AML 

 GCC: GCC JV-240UV, GCC MPC-240UV 

 Graphtec: CE6000-40Plus, CE6000-60Plus, CE6000-120Plus 

 Graphtec GPGL: CE6000-40Plus, CE6000-60Plus, CE6000-120Plus 

 Helitin: HT-P750-Water, HT-P750-Eco 

 HP: Latex 64 Cutter, Latex 54 Cutter 

 iECHO: iECHO 

 Jingwei: JWEI 

 MYCUT: MG630-AML, MS630-AML 

 TOTENW:  T33Q-AML, T53Q-AML, T73Q-AML, T33SQ-AML, T53SQ-AML, T73SQ-AML, 

EST850Q-AML, EST1350Q-AML, EST1850Q-AML, EST850SQ-AML, EST1350SQ-AML, 

EST1850SQ-AML 

 Vinyl Express: Rogue, Rogue Pro, Rogue Plus 

 

 
SAi Flexi 12 (SP3) 
Build 2568 
June 2nd 2017 
 
Bug Fixes 
 

 Fixed Hebrew fonts display issue, other translation issues  

 Fixed Flexi Designer Vectorizing tools not active for some .jpg files 



 Fixed Flexi Artwork Approval Tool not showing metric units 

 Fixed EPS files not opening correctly in Flexi Designer 

 Fixed Cut Condition sent incorrectly 

 Contour line properties now saved as layers file saved as PDF/EPS 

 Fixed image size varies after users adds crop marks 

 Fixed job not finished successfully error  

 Fixed issue with Spot White with RGB format 

 Fixed crash when Job Info comments are very long 

 Added Fotoba horizontal marks that also add a margin in between tiles on the same row 

 Fixed Production Manager to maintain original color of contour lines in files 

 Fixed Mutoh VJ-628x print issue 

 Fixed Preview Window of the processed job so it appears in the preview section and not 

one of the next jobs in the Hold queue 

 Fixed HP L65500 giving an error message before printing process "Not enough Disk 

space" 

 Fixed precision of contour cut paths added to bitmaps  

 Fixed Finishing Tools where the preview shifts after processing, one side of the bleed is 

not printed and adding a bleed a small white margin is added 

 Fixed Epson SC-S80600 error printing with vertical offset, using a custom (8-bit) profile 

resulted in file format error 

 Fixed objects disappearing or with gradient changing shape when sent from Flexi 

Designer RIP and Print Dialog 

 Added poll size option to multiple Mutoh VJ models  

 Fixed issue with some gradients printing all white 

 Fixed Summa OPOS XY not printing correctly when color bar is turned on 

 Fixed issue where Cut Preview did not indicate holes being cut first 

 Fixed Summa S75T driver options velocity parameter miscalculation(1 mm = 2.5 mm) 

 Fixed Hotfolders reverting back to default Jobs path 

 Fixed cut jobs being sent to plotter out of order 

 Fixed Summa D140R Always advancing after the plot 

 Fixed "load HP Library fails" message when trying to add setup for HP T7200 

 Fixed shadow in PDF file not printing correctly 

 Fixed misplaced out file when using resolution 270x1440  

 Fixed issue with Grommets not printing print when proportional box was unchecked 

 Fixed Flexi icons to look bigger on hi-res monitors 

 Fixed HP Z 31000 not printing from Flexi 12 Build 2324 (SP2) 

Enhancements 
 

 Added Flexi Knowledge Base – http://bit.ly/FlexiHelp 

http://bit.ly/FlexiHelp


 Added ICC Media profiling wizard to Production Manager  

 Added Roland Soljet Pro III registration marks to Flexi Designer 

 Add SummaFlex marks to Flexi Designer 

 Added an icon for Send to EnRoute to the toolbar 

 Added Animated Cut Viewer enhancements 

 Allow moving objects relative to current position 

 Allow group layers by condition 

 Allow Cutting order by layers and cutting by layer 

 Added Reset buttons on each cut/plot tab 

 Added showing cutting direction 

 Allow grouping of vinyl colors by condition 

 Added spacing between horizontal and vertical copies 

 Added ability to pause between specific colors / layers 

 Added corner style to rectangular contour cut 

 Added Advance After Plot, which allows the user to set a certain distance to advance 

after plotting 

 Added separate embedded ICC profile option per color mode 

 Other miscellaneous improvements 

New Features for Subscription Licenses 

 Added Cut Options per pass 

 Added DXF file dashed line recognition 

 Added close contours on import from DXF file 

 Added auto tile and smart nest in Flexi Designer  

 Added Cleave by Path and Vector Eraser Tool in Flexi Designer 

 Added set registration marks relative to media 

 Added check of only contour cut lines in Preview 

 Contour cut lines now include color specification 

 Added Unmask all 

 Added Interleave Copies 

 Added Profile Analyzer Tool 

Enhancements for Graphtec Cutting Device Drivers  

 Expanded cutting area 

 Added Type 1 and 2 registration marks 

 Added Segment Area Compensation 

 Added Registration Marks Offset 

 Devices come with pre-installed media types 

 Added 2 and 3 points registration marks 



 Added Segment Area Compensation 

 Added UI to show and change the cutter's identity number 

 Added new media sizes 

 
New Printer Drivers 
 

 ADDTOP: ADD-KM512-14pl-5C-D, ADD-KM512-14pl-7C-D, ADD-DX5-5C-H, ADD-DX5-5C-
B, ADD-SE-4S--W, ADD-SE-4S--S, ADD-KM512-14pl-5C-B, ADD-KM512-14pl-7C-B, ADD-
TE-E-6C, ADD-SE-4S--W-8C, ADD-SE-4S--S-8C, ADD-TE-E1-6C, ADD-TE-E1-6C, ADD-TE-E3-
6C, ADD-TE-U1-6C, ADD-TE-U3-6C 

 AM.CO.ZA: FastCOLOUR F-1860 Eco, FastCOLOUR F-1620 Eco, FastCOLOUR F-1820, 
FastCOLOUR F-1620, FastCOLOUR UV, FastCOLOUR DX5T Eco, FastCOLOUR DX5T Dye, 
FastCOLOUR W5113 Dye, FastCOLOUR W5113 Sublimation, FastCOLOUR GT-DX5, 
FastCOLOUR GT-W5 

 Aojet: Aojet H2512G, Aojet H2512K 

 ArtisJet: Artis-5000U 

 AShow: AShow_Ricoh, AShow_Toshiba, AShow_KM1024 

 AUDLEY: AUDLEY-4C, AUDLEY-6C, AUDLEY-NC-DX, AUDLEY-DX-4C, AUDLEY-S8, AUDLEY-
NC-DX-WV, AUDLEY-EP5113, AUDLEY-GEN5, AUDLEY-UV-D8 

 Azon: Indy UV Pro, Elektrojet, Indy DTS Pro, Indy Tex Pro, Edge, Soniq, DTS, Rotax, Hale, 
Matrix Tex, Matrix UV, Matrix DTS, Matrix UV Pro, Matrix DTS Pro, Matrix Tex Pro, DTS 
Grande 

 Bass Bowei: Bass Bowei-1610UV-G4, Bass Bowei-1610UV-G5, Bass Bowei-2512UV-G5, 
Bass Bowei-2513UV-G5, Bass Bowei-2030UV-G5, Bass Bowei-1610UV-GEN5 

 BOSSRON: WT-1802A-DX5, WT-1802A-DX7, WT-1802A-DX5113, WT-1700G-DX5, WT-
1700G-DX7, WT-1700G-DX5113, WT-3304L-512I, WT-3308-512I, WT-1325UV-G5, WT-
3300V-G5 

 Britomatics: Kingfisher BHYX 

 BYHX: BYHX-SG1024-5C, BYHX-SG1024-6C 

 Canon: imagePROGRAF PRO-1000, imagePROGRAF PRO-2000, imagePROGRAF PRO-
4000s, imagePROGRAF PRO-6000s, imagePROGRAF PRO-4000 

 CET: Color K Series 

 ColorJet: Polo Turbo, IrisJet, IRISJET PRO 

 Delone: Delone-KM-512-14PL, Delone-KM-512-42PL, Delone-KM-1024-14PL, Delone-
KM-1024-42PL, Delone-KM-1024-14PL-UV, Delone-KM-1024-6PL, Delone-KM-1024i-
13PL, Delone-KM-512i-30PL, Delone-DX5-ECO, Delone-DX5-Water, Delone-DX5-UV, 
Delone-KM-512i-30PL-180, Delone-Ricoh2220-3PL, Delone-GEN5-7PL-Water, Delone-
GEN5-7PL-UV, Delone-DX7-ECO, Delone-DX7-Water 

 DIGIPRINTER: DIGIPRINTER-KM-512-14PL, DIGIPRINTER-KM-512-42PL, DIGIPRINTER-KM-
1024-14PL, DIGIPRINTER-KM-1024-42PL, DIGIPRINTER-KM-1024-14PL-UV, DIGIPRINTER-
KM-1024-6PL, DIGIPRINTER-KM-1024i-13PL, DIGIPRINTER-KM-512i-30PL, DIGIPRINTER-
DX5-ECO, DIGIPRINTER-DX5-Water, DIGIPRINTER-DX5-UV, DIGIPRINTER-KM-512i-30PL-



180, DIGIPRINTER-Ricoh2220-3PL, DIGIPRINTER-GEN5-7PL-Water, DIGIPRINTER-GEN5-
7PL-UV, DIGIPRINTER-DX7-ECO, DIGIPRINTER-DX7-Water 

 Digital Printer: TT-PC3200-4C, TT-6H-4, TT-6C-2-540 ECO, TT-6H-WV, TT-6C-WV, TT-6C-2 
WV, TT-Toshiba-4-UV, TT-Toshiba-4, TT-4C WV 

 DYSC: DYSC-DX_A, DYSC-DX_B, DYSC-SK_A, DYSC-SK_B, DYSC-SK_B_G_W, DYSC-
LK_ADYSC, DYSC-DX_A, DYSC-DX_B, DYSC-SK_A, DYSC-SK_B, DYSC-SK_B_G_W, DYSC-
LK_A 

 DYSS: DYSS-GF-2616-12FRWRV, DYSS-GH-1600-10FMW, DYSS-GH-2200-12FRWRV, 
DYSS-GF2630-16FMVMPFWW, DYSS-GM-6042N-CMYK_WV, DYSS-GF-2616-12FRW, 
DYSS-GF-2613-12FRW, DYSS-GH-2600-16SFW, DYSS-GH-2200-12FRW, DYSS-GH2200-4F, 
DYSS-GH-2200-10FMW 

 EDAHIGHT: EDAHIGHT-SK_B_G_W, EDAHIGHT-LK_A 

 Ejet: Ejet-Locor, Ejet-Magic, Ejet-RICOH GN_5_195, Ejet-RICOH GN_5_130, Ejet-Single-1, 
Ejet-Single-2, Ejet-Single-3, Ejet-Dual-1, Ejet-Dual-2, Ejet-Dual-3, Ejet-Dual-4, Ejet-RICOH 
GN_5_6C_320, Ejet-EP6-SW, Ejet-EP-5X, Ejet-EP-8X, Ejet-EP-6X, Ejet-Single-4 

 Epson: SC-P800, SC-P807, SC-P808, SC-PX3V 

 ESS: ESS E 1601SW, ESS E 1802SW, ESS E 1804SW, ESS K 320SSW, ESS E 3204S SW, ESS 
Q320S, ESS EUV 180 R and R, ESS KUV 180 Hybrid, ESS KUV 320 R and R, ESS QUV 320 R 
and R, ESS KUV 320 Hybrid 

 Fabic: TX-1800 

 FANGDA TEX: FANGDA TEX-4C, FANGDA TEX-8C, FANGDA TEX-5C, FANGDA TEX-6C 

 Fei Yeung Union: FY-3212, FY-SPT1536GS-6C, FY-1012PS, FY-3212-35PL, FY-3212-50PL, 
FY-2030A, FY-SPT1536GS-8C 

 Flora Texilte: Flora-Gen5Ink600, Flora-Gen5Ink605, Flora-Gen5UV360, Flora-
Gen5UV363, Flora-TJet100-8Gen5, Flora-GJet200, Flora-TJet200-8Gen5 

 Fortune: YF-2000D, YF-3200D, YF-3200UV, YF-W5113, YF-3200G, YF-3200G-S, YF-1700X, 
YF-1700S, YF-1700XUV, YF-3200G-SUB, YF-3200UV-7, YF-2000D-7 

 Fujifilm: Acuity LED 1600 

 Gethray: Gethray-BYHX-EPSON_5113, Gethray-BYHX-EPSON_2-UV, Gethray-BYHX 
KM512I-30PL-4C, Gethray-UMC Gen5, Gethray-UMC KM512i-30pl-4C, Gethray-BYHX-
KM1024-14PL, Gethray-BYHX-KM1024-42PL 

 Glitter: Glitter-DX7, Glitter-SPT35, Glitter-SPT50, Glitter-KM512i, Glitter-EP5113 

 HandTop: HandTop HT2512UV-R, HandTop HT2500UV-R, HandTop HT1610UV-R5 

 HuiFanTong: HFT-4C, HFT-6C, HFT-5113-3L 

 Helitin: HT-EP-Eco, HT-P500-Water, HT-P500-Eco, HT-FL1200, HT-PP400, HT-FP0405, HT-
FP0645, HT-FP0609, HT-FP1209, HT-FP2513 

 HP: HP Latex 560, HP Latex 570, HP Latex 375, HP Latex 365, HP Latex 335, HP Latex 315, 
HP Latex 1500, HP Latex 3500, HP Latex 3100, DesignJet Z5600, DesignJet Z2600 

 HeXuan: HX-DX-YL, HX-DX-BH, HX-RH-BH, HX-LMHB-4C, HX-DX-YL-8C, HX-RH-W-BH, HX-
RH-DPS, HX-RH-RY, HongRun, HR-H5000UVK, HR-H3200UVK, HR-P2500UVK, HR-
F1800UVS, HR-T1800K 

 Human Digital: HM-H DX5 4C, HM-H DX5 8C, HM-H 5113-3L, HM-H 5113-3L 150D, HM-
DP 512-1024-14pl, HM-DP 512-1024-42pl, HM-DP 512i-30pl, HM-DP 512-1024-14pl UV, 



HM-DP 512i-13pl UV, HM-DP 1024i-13pl UV, HM-DP 512i-13pl TEX, HM-D 1024i-13PL 
TEX, HM-DP KM512i-1024i-6pl TEX, HM Q-JET Plus HM3200, HM-B DX5 4C, HM-B DX5 
8C, HM-B KM256-42pl, HM-B KM256-14pl, HM-B KM512-1024-42PL, HM-B KM512-
1024-14PL, HM-B 1024-14PL UV, HM Combo-JET 4800, HM-B 1024-6PL UV, HM-B 512i-
13pl UV, HM-B 1024i-13pl UV, HM-B 512-1024i 13pl TEX 

 HYL Printer: HYL1501, HYL-UV-4C-WV-D2, HYL-UV-4C-WV-D3, HYL-UV-6C-WV-D2, HYL-
UV-6C-WV-D3, HYL-TX4C-D2, HYL-TX4C-D3, HYL-TX6C-D2, HYL-TX6C-D3, HYL-TX8C-D2, 
HYL-TX8C-D3 

 InkJet Printer: InkJet Sign740, InkJet Sign1260, InkJet Dream740, InkJet Dream1260, 
InkJet Pre740, InkJet Pre1260 

 Jetrix: RX3200, RX5000, RX320G 

 JingMei: JM-K1024-G-W 

 Keditec: Keditec-SG1024-12PL, Keditec-SG1024-30PL, Keditec-6C-150, Keditec-Gen5-
1CH-UV, Keditec-Gen5-2CH-UV, Keditec-Gen5-UV3200, Keditec_RICOH, 
Keditec_Wrich_GEN5, Keditec-M3200UV-J 

 KingJet: KingJet-XAAR 1002-RY-8C, KingJet-XAAR 1002-SD-8C, KingJet-SG1024-BYHX-8C, 
KingJet-XAAR 1002-RY-12C, KingJet-XAAR 1002-SD-12C, KingJet-SG1024-BYHX-12C 

 KINGT: KINGT-1610, KINGT-2513, KINGT-2030, KINGT-4550, KINGT-4550C, KINGT-1010C, 
KINGT-1016C, KINGT-4230C 

 LongKe: LongKe-Ricoh-UV2513, LongKe-Ricoh-UV2030, LongKe-Ricoh-UV1325, LongKe-
Ricoh-UV3040, LongKe-SPT1020-UV2513, LongKe-SPT1020-UV2030, LongKe-SPT1020-
UV1325, LongKe-SPT1020-UV3040, LongKe-Ricoh-4C, LongKe-Ricoh-6C, LongKe-Ricoh-
UV3200ROLL, LongKe-Ricoh-2530, LongKe-Ricoh-W, LongKe-Ricoh-UV5200ROLL, 
LongKe-SPT1020-UV5200ROLL, LongKe-Ricoh-UV5200-10C, LongKe-Ricoh-10C 

 MARS: MARS EPDX5, MARS HS EPDX5, MARS BYHX KM512i-30pl, MARS UMC KM512i-
30pl, MARS HS W5113, MARS BYHX KM1024-14pl 

 Maxcan: MCC-GEN, MCC-GEN-B, MCC-GEN-C, MCC-DX-TX, MCC-GEN-4C-WV, MCC-GEN-
6C-WV 

 Metalnox: EPrint Strong Gen 5, EPrint Strong V2 

 Micolor: MC-5800, MC-5800D 

 Mimaki: JV33-160 OPALTONE, UJV55-320, UJF-7151, TS300P, TX-300P, JV33-130BS, 
JV33-160BS, JV33-260BS, CJV30-60BS, CJV30-100BS, CJV30-130BS, CJV30-160BS, TX-
500B 

 Mutoh: VJ-1638UH, VJ-1604X, VJ-1604WX, VJ-1938X 

 MyJet: MyJet_EPSON_UV, MyJet_EPSON_DX5S, MyJet_EPSON_DX7S, MyJet_EPSON_W, 
MyJet_XAAR382_35, MyJet_XAAR382_60, MyJet_KONICA512_42, 
MyJet_KONICA512_14, MyJet_KONICA512i, MyJet_KONICA1024_42, 
MyJet_KONICA1024_14, MyJet_Starfire1024 

 NKT: Ceramic 

 Nocai: Nocai-UV-DX0406, Nocai-UV-DX0609, Nocai-RICOH2513, Nocai-UV-DX0609-NEW, 
Nocai-UV-DX0615 

 OKI Data: ColorPainter E-64s (IP-5630), ColorPainter E-54s (IP-5530) 

 Oric: Oric GH2200, Oric DX5-2WV, Oric DX5-B, Oric BE-1800 



 Polar: PL-1850, PL-1860, PL-1950, PL-1960, PL-3300 

 Polygon: HZ-DX5, HZ-DX6-3L, HZ-DX6-4L 

 PrintPretty: Niprint SF1024-4C, Niprint SF1024-8C, Niprint SM4C-1H, Niprint SM4C-2H, 
Niprint AJ1806-UV, Niprint A6080T 

 PrismJet: PrismJET VJ24, PrismJET VJ24X 

 REVOTECH: REVOTECH-KNE-TX, REVOTECH-KHE-TX, REVOTECH-KHE-6PL-TX, REVOTECH-
KM1800I-3PL 

 Ricoh: Ricoh Pro L4130, Ricoh Pro L4160 

 RIPControl: PRINTTYPE-SC-WF5113, PRINTTYPE-SJ-WF5113, PRINTTYPE-SC-XP600, 
PRINTTYPE-SJ-XP600, PRINTTYPE-TC1932-X, PRINTTYPE-4180UV 

 Roland: TrueVIS VG-640, TrueVIS VG-540, SOLJET PRO 4 XR-640 OPALTONE, EJ-640, 
VersaUV LEF-300, TrueVIS SG-540, TrueVIS SG-300 

 Saturno: SaturnoJet 

 Saven: KinColor G5 RICOH-4C, KinColor G5 RICOH-6C, KinColor 3016SG 

 Shenou: Shenou FlatBed, Shenou HT, Shenou RICOH_WV, Shenou RICOH 

 SID Signs: SID GALAXY TOSHIBA UV, SID GALAXY TOSHIBA ECO 

 SignStar: SignStar-SJP1902WF, SignStar-SJP3202WF, SignStar-SJP1902E6, SignStar-TPW-
1902, SignStar-SJ3202V, SignStar-SUV3202, SignStar-GHR3208WN, SignStar-
GHR3208WN2 

 SinoColor: SignJet-SC1800, SignJet-SC3200, DreamJet 740, DreamJet 1260, PreJet 740, 
PreJet 1260 

 Skycolor: STORMJET-XP600, FEDAR-TC1932-X, SKYCOLOR-4180UV, SKYCOLOR-Ricoh, 
SKYCOLOR-ZT-XP600 

 Titan: TT-PC3200-4C, TT-6H-4, TT-6C-2-540 ECO, TT-6H-WV, TT-6C-WV, TT-6C-2 WV, TT-
Toshiba-4-UV, TT-Toshiba-4, TT-4C WV 

 Twinjet: Twinjet RH-1862, Twinjet RH-1864, Twinjet RH-1824, Twinjet RH-1826, Twinjet 
SJ-1817Pro, Twinjet BYHX-DX5-8C, Twinjet BYHX-DX5113 

 WanZheng: WZ-FRT2536KA, WZ-FRT2536KB, WZ-FRT2536GA, WZ-FRT2536GB, WZ-
FRT3225KA, WZ-FRT3225KB, WZ-FRT3225GA, WZ-FRT3225GB, WZ-FR3210KA, WZ-
FR3210KB, WZ-FR3210GA, WZ-FR3210GB, WZ-R3300KA, WZ-R3300KB, WZ-R3300GA, 
WZ-R3300GB 

 Xenons: Xenons DX-5113, Xenons M5, Xenons X5300RE, Xenons M5-W, Xenons 4740-H 

 XinHaiSheng: XHS-2H-4C, XHS-2H-6C, XHS-2H-8C, XHS-1H-4C, XHS-1H-6C, XHS-1H-8C, 
XHS-1H-UV, XHS-2H-UV, XHS-5C-UV, XHS-7C-UV, XHS-8C-TX, XHS-AURA-4C, XHS-AURA-
6C, XHS-AURA-8C, XHS-RM-4C, XHS-RM-8C, XHS-5113-8C, XHS-5113-3L-8C, XHS-
TX800UV, XHS-TX800UV-3L 

 Xkeda: XLF_DX5DX7_150, XLF_DX5DX7_180, XLF_DX5DX7_HS_150, XLF_DX5DX7_HS, 
XLF_DX6_HS, XLF_W5113_HS, XLF_CE4 

 YUEDA: YD-1800-XE, YD-2513-RA, YD-3200-KC, YD-1510-RA, YD-3200-RC, YD-2600-RC, 
YD-2600-KC, YD-1810-RD, YD-6090-RA, YD-1640-SF 

 ZICHCUANG: FC-G5-4C, FC-G5-6C, FC-SK1020-4C, FC-SK1020-6C 

 ZIER: ZIER-SPT-508GS, ZIER-DX7, ZIER-DX5, ZIER-SPT35, ZIER-SPT50, ZIER-KM512i, ZIER-
DX5113 



 
New Cutter drivers 
 

 AM.CO.ZA: AM-Generic DMPL, AM-Generic HPGL, V-Series V-850, V-Series V-1130, V-
Series V-1330, V-Series V-1660, V-Smart V3-440, V-Smart V3-740, V-Smart V3-1080, V-
Smart V3-1310, V-Smart V3-1660, V-Series V-360, V-Series V-800, V-Series V-1120, V-
Series V-1360, V-Series V-1700, V-Auto V6-900-AML, V-Auto V6-1500-AML, V-Auto V6-
1800-AML 

 Aristo: TL 1917, TL 1925, LFC 2332, LFC 2352, LFC 2372, LFC 3332, LFC 3352, LFC 3372, 
LFC 5232, LFC 5252, LFC 5272, TL 19xx-C, GL 20xx-C, TL 13xx-C, TL 16xx-C, LFC 23xx-C, 
LFC 33xx-C, LFC 52xx-C 

 AZONColor: CC12W, CC24W, CC64W, CC59-AML 

 CAMFive: CFC-S24, CFC-S48, CFC-S61, CFC-A75, CFC-A130, CFC-A165, CFC-AML 

 CutterPro-Auto: CutterPro-AML, Teneth-AML, TS-AML 

 CuttingPro: Servo-59L, Servo-1500L, CutterPro-AML 

 BannerCut: Bannercut 30cm LD, Bannercut 60cm LD, Bannercut 130cm LD, Bannercut 
160cm LD, BannerCut-AML 

 Foison: S Pro-AML, S24 Pro, S48 Pro, S60 Pro, C60 PRO, FLAT BED, X-Series 

 GMY: Flatcut-C 

 Graphtec: FC4500-50/FC4550-50, DLP1000, FCX2000-180, FCX2000-120, FCX2000-60, 
DLC1000 

 Helitin: HT-P500-Water, HT-P500-Eco, HT-FL1200 

 ICUTTER: S Pro-AML, S24 Pro, S48 Pro, S60 Pro, V60 PRO 

 INK SPA: CT-440L, CT-740L, CT-1300L, CT-1660L, CT-AML 

 King Rabbit: HX-AML-HPGL, HX-AML-DMPL 

 Mimaki: CFL-605RT, CF3-1610, CF3-1631, CJV30-60BS, CJV30-100BS, CJV30-130BS, 
CJV30-160BS 

 PIXELMAKER: PM-440, PM-740, PM-1300, PM-AML 

 POLARIS: POLARIS 440, POLARIS 740, POLARIS 1300, POLARIS 1660, POLARIS-AML 

 Roland: TrueVIS VG-640, TrueVIS VG-540, SOLJET PRO 4 XR-640 OPALTONE, TrueVIS SG-
540, TrueVIS SG-300, GR Series 

 Servo Cutter: TS-AML, CC-AML, Servo-AML 

 Sign World: C60 PRO, FLAT BED, S Pro-AML, S24 Pro, S48 Pro, S60 Pro 

 Sky: N12, N15, N24, N30, N48, H12, H15, H24, H30, H48, D12, D15, D24, D30, D48, D12-
AML, D15-AML, D24-AML, D30-AML, D48-AML 

 SUCHI: SUCHI-AML 

 Summa: D160 SE 

 USCutter: TITAN3 28, TITAN3 53, TITAN3 68 

 Vicsign: Q3-AML, Q4-AML 

 Vinyl Express: EnduraCUT 3 
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Bug Fixes 
 

 Multiple copy jobs sent to Grapthec GPGL no longer cut multiple times 

 PDF and EPS files with CMYK indexed images are now handled correctly 

 Fixed an issue with rendering of overprinted spot channels 

 Fixed an issue with Find File crashing when the searched folders have many hierarchies of sub-

folders 

 Fixed an issue where Flexi would crash when trying to load corrupted preferences 

 The list of File Types in Add Job is now displayed correctly 

 Registration marks are now applied correctly when adding nested print and cut jobs with 

Default job properties set to center align 

 Cut options are now applied correctly on the Roland GX640 

 Fixed an issue with printing Spot Colors 

 Uploading jobs to the Approval tool in metrics will now display correctly on the customer 

website 

 Fixed an issue with simultaneous printing to HP Latex 200 and 300 series 

New Printer Drivers 
 
 HP: DesignJet T7200, DesignJet T3500, DesignJet T730 36, DesignJet T830 36, DesignJet T930 36, 

DesignJet T1530 36, DesignJet T2530 36, PageWide XL 8000, PageWide XL 5000, PageWide XL 

4500, PageWide XL 4000 

 Epson: SC-S70675, SC-S50675, SC-S30675, SC-P600, SC-P20000, SC-P10000, SC-P20070, SC-

P10070, SC-P20080, SC-P10080, SC-P20050, SC-P10050, SC-S40600, SC-S60600, SC-S40610, SC-

S60610, SC-S40670, SC-S60670, SC-S40680, SC-S60680, SC-S40650, SC-S60650, SC-S80600, SC-

S80610, SC-S80650, SC-S80670, SC-S80680, SC-F6070, SC-F6200, SC-F7200, SC-F6270, SC-F7270, 

SC-F6280, SC-F7280, SC-F9270, SC-F9280 

 Mimaki: TS30, TS500P, JFX200-2513 

 Mutoh : VJ-1324X (ValueJet), VJ-1624X (ValueJet), VJ-1624WX (ValueJet), VJ-1924WX (ValueJet), 

VJ-2638X, VJ-1938TX 

 Roland : XT-640, VersaEXPRESS RF-640A 

 
New Cutter Drivers 
 

 Comagrav: Comagrav 

 Mimaki : CF-0907-2-S, CF-0912-2-S, CF-1215-2-S, CF-1218-2-S 
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Bug Fixes 
 
 Labels containing Japanese characters now print correctly 

 Re-arranging production manager queue columns now displays the data correctly 

 Fixed an issue with the Bitmap Pro driver containing black dots in white underbase and fill 

 Fixed a crash that might occur when using rational angled screen with CMYKLcLm color modes 

 Files containing spot colors with empty names will now print correctly when sending from the 

RIP and Print dialog 

 Default Job Properties tabs for hybrid devices now display correctly 

 Fixed a crash that might occur when sending a print and cut file with masks 

 QR codes now display and print correctly 

 Fixed an issue with sending icc profiler targets in RGB 8 bit mode 

 Profiler will now ignore presets that were set in default job properties 

 Fixed a crash that might occur when combining stochastic dither with 3x4 resolutions 

 Combining purify gray with CleanColor no longer prints too light  

 Brand name of Hewlett Packard setups has been renamed to HP 

 Fixed a crash that might occur when using a background fill on grouped and locked frames 

 Duplicate setup in SE now work correctly 

 Fixed an issue with the French translation of certain menu items not displaying correctly 

 Production manager device icons have been updated 

 Color bands with SO Diffusion and Smooth Gradients now print correctly 

 Fixed an issue where certain PDF/PS would rip slower if the ignore overprint option was 

unchecked 

 Cut after printing now works correctly on hybrid devices 

 Fixed an issue with hybrid devices using registration marks where sometimes the bottom line of 

a contour path was not cut 

 
New Printer Drivers 
 
 HP : Scitex FB550, Scitex FB750 

 Roland : VersaStudio BN-20 ECO-SOL MAX3 

 Lecai : LC-G5 Flag Printer, LC-Deluxejet 18SG+, LC-Deluxejet 32SG+ 
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New Product Levels 

Flexi 12 has a completely new product line up that replaces the previous product levels and is better 
tailored to your needs  

 FlexiSIGN&PRINT 



This SAi flagship product offers the total solution for print, print-and-cut and direct-to-vinyl 

production workflow. It includes a powerful production manager with a complete wide-format 

production feature set as well as a complete design application that makes sign and print design 

easy. 

 

 FlexiPRINT 
This product has everything wide-format print businesses need for easy print and print-and-cut 

production. In addition to versatile nesting and tiling features, it also includes banner finishing, 

textile step-and-repeat and spot color matching and more. Also enjoy the industry's most 

seamless print-and-cut workflow that allows you to add multiple contour cut lines to any design 

in the fewest steps. 

 

 FlexiSIGN 

This product has everything professional sign makers need for direct-to-vinyl design and cutting. It 

includes full graphic design, text serialization and color tracing features. It also has drivers for 

over 1000 cutter models and unique features to optimize cutting speed and make weeding 

faster and easier. 

 

  



New Design Features 

 View and change object order.  Flexi now lets you reorder the objects more intuitively, by 

selecting the objects in order, as well as having the option to optimize cutting start points. 

Access this feature via Arrange > Cut Order > Reorder. 

 Preview how a job will be cut in the Animated Cut Viewer.  Go to Arrange > Cut Order > Preview. 

 You can now open and import multiple files at once.  When you open multiple files, an .fs file 

will be created for each.  When you import multiple files, your cursor will show a bounding box 

for each file.  Click to position the first one, then click again to position the next. 

 QR Code is now available for non-subscription users. 

 2D Data Matrix codes have been added.  Type in text and select Text > Data Matrix > Text to 

Data Matrix. 

 Artwork Approval Tool.  Send Artwork out for approval to your customers before producing.  

Your customer will receive a website link to view the artwork you created and will be able to 

either add comments or approve.  You can upload several revisions and monitor the status of 

each Artwork Approval Task.  Create a job and select File > Send to Approval Tool to get started.   

Access the overview of all Approval jobs via the Job Approval icon in the Cloud window. 

 Added True Shape Nesting for images with Contour Paths. 

 Drawing placeholders for templates can now be scaled non-proportionally. 

 The Send As E-mail feature now has a ‘selection only’ option. 

 Flexi now supports TIFF files in planar format. 

 The SummaFlex Swatch Library has now been added to Flexi. 

 Cloud File Storage has been increased to 5GB. 

 

New Production Manager Features 

 Updated Look and Feel.  All levels of Production Manager now have a thumbnail preview in the 

queue for the selected job.  All printing levels have a separate Hold, RIP and Output queue. 

 Nesting Alignment Tools.  Production Manager now allows more control over nested jobs.  You 

can now select multiple jobs in a nest and align them either relative to each other or relative to 

the media edges. 

 Apply Same Size to nested jobs.  Select multiple files in a job nest and hit the Same Width or 

Same Height icons on the layout tab of Job Properties. 

 Banner and Canvas finishing tools are now available to non-subscription users.   Add grommets, 

fold and bleed to your jobs. 

 Rectangular grommets and bleed option for corners of mirror and repeat bleeds have been 

added to the Finishing tools. 

 Choke and Bleed.  For color modes containing spot ink channels such as white or metallic, you 

can now define Choke or Bleed.  Access this feature by selecting a color mode with a spot ink 

and hitting the Choke button.   

 Smoother Gradients.  Access this feature on the Color Management tab of Job Properties dialog 

or RIP and Print dialog.  Gradients in EPS/PDF print jobs will be processed at a very high gradient 

precision, which will especially have an effect on lighter gradients rendered at larger sizes.  



 Improved Pure Hue tool.  Pure Hue can now be applied to all Primary and Secondary colors as 

well as to Gray, as well as achieving better transitions with neighboring colors. 

 CleanColor™ provides an alternative pure hue method. Whereas standard pure hue bypasses 

color management and will keep input values as output, CleanColor™ first processes the color 

through ICC profiles and will then remove any channels that might have been added. This 

method may achieve more balanced colors than standard pure hue. 

 Tiling settings can now be saved into Default Job Properties and presets. 

 PANTONE Plus Libraries have been added to Production Manager Global Color Mapping.  The 

choice between old PANTONE values or PANTONE Plus can be set in the Global Color Mapping 

dialog.  PANTONE Plus is now set as default. 

 Automatic gradient recognition for legacy EPS files.  Older .EPS formats were not capble of 

storing gradients as vector objects and converted them to bands.  This feature which can be 

switched on/off in Preferences will automatically recognize one of these band gradients and 

convert them back into vector gradients, for smoother output. 

 Anti-Alias Text. This feature applies extra anti-aliasing to text in EPS/PDF jobs and was added 

especially to improve the look of very small and fine text.  When checked, it will apply to all text, 

even large but the effect will be mostly noticeable on smaller text. 

 Find printer for TCP/IP.  When adding a new printer in Production Manager with a TCP/IP port, it 

can now search the network to find available printers and their TCP/IP address.   Access this 

feature by hitting the Find Printer button when adding a new setup.   Not all printers support 

being polled for their IP Address. 

 Eliminate line segment overlap for contour jobs.  When 2 cut lines overlap, Production Manager 

will only cut the line once. 

 Added printing Tile Trim Lines to make it easier to cut long tiles to assemble, especially with 

white in the background, where the tile edge is difficult to see. You can access this feature from 

the Print Marks drop down menu on the Labels and Marks tab of Job Properties once a job is 

tiled. 

 Optiscout is now supported. 

 Added support for Rasterlink 6 to send print and cut jobs as single .eps files. 

 Added support for the SpyderPrint Spectro. 

 The Summa F-Series SummaFlex is now supported.  SummaFlex Mark Options allow you to 

control mark size and amount, the distance between job and marks.  Switch on barcodes for 

camera or for hand scanner. 

 

Improvements and Bug Fixes 

Design  

 PDF with Type 3 fonts are now imported correctly 

 Fixed an issue with drop shadow on capital A letters in certain fonts 

 PDF export of jobs with composites that contain a path with cut contour attribute now works 
correctly 

 Rhinestone paths will now be kept after applying path editing tools such as scissor and cleaver 

 Improved spell checker for files with a very large amount of text objects 



 Fixed an issue in DesignCentral for outlines and shadows where sometimes the Apply message 

would be lost 

 Copying bitmaps from Firefox to Flexi now works correctly. 

 It is now possible to assign a different color to QR and Data Matrix codes 

 Flexi will now automatically detect the location of the Adobe PhotoShop CC Plug-in folder 

 The default monitor profile has now been set to sRGB   

 It is now possible to select another bitmap when using the bitmap fill tool without needing to 

exit the tool first between switching bitmaps 

 Archive to Cloud will now wait until the upload of one file is completed before allowing a next 

upload 

 Fixed a crash when using the bitmap eraser tool on a transparent bitmap to erase to original 

 PDF files containing masks with winding fill are now imported correctly 

 Fixed a crash that might occur when loading certain .fs files containing spot color mapping 

 Contour cut objects with fill only and no strokes are now displayed correctly 

 Fixed an issue with generating underbase white for TIFF or JPG 

 The alternative colors for exporting Pantone to PDF will now be calculated based on LAB values 

instead of the base colors 

 .sci files now open correctly 

 In the Arrange > Nest tool, the default panel height is now set to the document height 

 The Color Mixer out of gamut alert is now based on DeltaE 2000 larger than 2 

 Open paths in PDF files with a fill and only 2 points will not be closed  automatically on import 

 Improved the display of PANTONE color gradients in soft proofing 

 Added export to Flexi 8.0 format 

 Fixed a crash that might occur when opening .fs files containing shared brush items for outline 

or shadow 

 Sending a design that has a pattern brush with a transparent bitmap to a desktop printer no 

longer crashes 

 Palette View is now working correctly 

 Fixed a crash that might occur when creating outlines for very complex paths 

 If the color of a cut contour path is not one of the CutContour spot colors, Flexi will 

automatically assign a CutContour spot color upon export to .EPS 

 PDF based AI files can now be imported as linked 

 Custom changes in Casmate workspaces are now saved correctly 

 Fixed an issue with importing PDF files containing pattern fills with column spacing that is very 

close to -100% 

 Fixed an issue opening complicated .fs files with nested effects 

 Layers now import in the order specified in the original document instead of alphabetically 

 Fixed an issue that sometimes thumbnail images were not generated when saving .fs files 

 .fs files with dash pattern strokes now load the dash pattern correctly 

 After archiving a file to cloud, Flexi now prompts to save the file locally before exiting 

 Auto-place on import now uses paste offsets specified in the Preferences dialog 

 Meter limits are now kept on the inside paths for strokes when importing .ai files 

 Fixed an issue importing PDF X4 files with PANTONE spot colors 



 Zoom center now updates correctly with pan scroll 

 License Manager shortcut is now available in the Program Groups 

 

RIP&Print and Cut/Plot 

 Custom Spot Color mapping is now applied correctly when sending files with spot colors from 

the Rip and Print dialog 

 Jobs sent from Flexi Rip and Print as Send Now will no longer be on hold when the Autoload 

Preview option is switched on in Production Manager preferences 

 Flexi RIP and Print now remembers media size changes for the next job 

 The list of ICC profiles now loads faster on the RIP and Print dialog when there is a long list of 

profiles 

 For contour cut jobs, when the cutter is smaller than the printer, Flexi will only alert once about 

the difference in size instead of with every job 

 The Cut/Plot and RIP and Print dialogs now remember user defined options when opening a new 

document 

 Masking paths that are used as cut contour paths are no longer being skipped for cut output 

 The RIP and Print dialog will now use the cut mark options that are set in Default Job Properties 

of Production Manager 

 Changes in Color Adjustment Curves made in the RIP and Print dialog are now stored to 

preferences and inside the .fs file 

 RIP and Print will now read the default selected label color from Production manager 

 

 

Production Manager 

 All Zund ZCC cut types are now supported 

 Zund ZCC barcode number is now added to the file name for easy visual reference 

 Fixed an inconsistency of Zund ZCC mark placements between print and cut 

 The default extension for Zund ZCC files has been changed to .zcc 

 Fixed an issue when loading grommet settings from presets 

 Summa barcode and XY lines now extend over all pages of multipage PDF jobs 

 Nested jobs with both print only jobs and jobs with contour cut paths will now generate the cut 

job correctly 

 Fixed a mismatch between print and cut when the output has many rows of small jobs as well as 

cut marks 

 Fixed a mismatch between preview and output where sometimes the preview would allow more 

objects on a row than in output 

 Output ICC profiles from presets now apply correctly to all sub jobs of nested nobs 

 The finishing tool preview now have zoom and rulers 

 Embedded grayscale input ICC profiles now apply correctly 

 Negative Graphtec marks will now be in the center of the squares 



 When a default cutter is set in default job properties, registration marks will be skipped for jobs 

without contour cut paths 

 Invalid characters in ICC profile names will be removed automatically in Color Profiler 

 Variable White in RIP will now be generated by lightness instead of ink density 

 Color Adjustment curves from presets created in Production Manager are now set loaded 

correctly in the RIP and Print dialog 

 Improved rendering speed of files with spot color gradients 

 Fixed a crash that might occur in the Cut/Plot dialog with the tile all copies feature when there is 

no cut object in the job 

 When nesting jobs in Production Manager, sub jobs will be rotated automatically to avoid tiling 

 Advance after plot is now selected automatically when a repeat job is specified 

 Jobs can now be dragged across different sheets of media on flatbed printers in manual nesting 

 Fixed an issue with HP Latex Printers synchronizing media containing special characters 

 Fixed a crash that might occur when closing the Job Properties dialog while the preview is being 

generated for textile step and repeat 

 Renamed options for Graphtec marks. Size has been renamed to total size.  This option is for 

adjusting extra margins outside the marks.  Margin refers to the distance between the corners 

of the marks and the job.  Length has been renamed to Mark Length 

 Fixed an issue with opening Driver Properties for the Graphtec GPGL driver 

 Passmask now applies to spot channels such as white for Roland drivers that support it 

 Fixed an issue that might cause extra cut lines when the knife offset is not 0 

 Improved rendering of overprinted spot channels 

 Moving jobs with presets in non-English locales now works correctly 

 The automatic tile flip check box has been moved from the preferences dialog to the tiling tab of 

Default Job Properties 

 Fixed an issue with Repeat Job sent to Hybrid devices 

 Object Color Control now works for PDF files with transparency groups or transparent bitmaps 

 Fixed an issue where sometimes skipped separations were still printed 

 Nested jobs now apply the correct media and resolution when Job Properties are different from 

Default Job Properties 

 Fixed an issue that sometimes ink split was applied to ink limit targets when Default Job 

Properties had an ICC Profile set 

 Fixed an issue that when a different color than black was chosen for labels, the preview in 

Production Manager would still display it as black 

 In Job Properties, center on layout is now remembered when changing media size after setting 

positioning 

 Fixed an issue in the Save As dialog in Production Manager that sometimes a change in format 

selection was not being applied 

 The line width of Mutoh AASCII marks has now been changed to 0.1mm for large marks 

 Fixed an issue with printing separations with spot channels 

 Fixed a RIP error that might occur when the label color is a spot color that is also used in the 

design 



 Pages of Multipage PDF files are now kept side by side when assigning marks while center 

aligned 

 Job names are no longer truncated in Production Manager if the original .fs file name contains 

an extra period 

 The default value for Ignore Overprint is now unchecked 

 Fixed a RIP error that might occur with very small gradients 

 Margin and Border now print correctly on printers with RGB 8 bit color modes 

 When a mark is changed from margin to other types, the label width is now adjusted accordingly 

 The job previews in the main window for tiled print and cut jobs now display correctly. 

New Printer Drivers 

 DYSS: DYSS-GH-2200-16SFWFV,  DYSS-GF-2613-12FRWRV 

 Hewlett-Packard: HP Latex 370 Printer, HP Latex 110 Printer 

 Mimaki : JV300-130, JV300-160, CJV300-130, CJV300-160, JV150-130, JV150-160, CJV150-130, 

CJV150-160, CJV150-107, CJV150-75, JFX200-2131, UJV500-160, SIJ-320UV 

Mutoh: VJ-628X, VJ-1628X, VJ-1938WX,  VJ-1638WXLA 

 Roland: SOLJET PRO 4 XR-640 C, SOLJET PRO 4 XR-640 WMT, SOLJET PRO 4 XR-640 LkW, SOLJET 

PRO 4 XR-640 LkMT, Texart RT-640 

 SID : SID Triton Series 

 Titan: TT-4C DYE, TT-4C ECO, TT-6C DYE, TT-6C ECO, TT-6C-2 DYE, TT-6C-2 ECO, TT-8C-LLK, TT-8C-

LY,TT-8C-Textile, TT-8C-WV, TT-Ricoh-4C, TT-Ricoh-6C, TT-Ricoh-Textile, TT-Ricoh-UV,  

 Xenons 4740TX-8C, Xenons 4740TX-6C, Xenons 4740TX-4C, Xenons RICOH-WV 

New Cutter Drivers 

 AZONColor: CC64w, CC24a, CC48a, CC64a 

 Eurosystems: Optiscout 

 GO: GO MaxCut ARS 

 Mimaki: CJV300-130, CJV300-160, CJV150-130, CJV150-160, CJV150-107, CJV150-75 

 Roland: SOLJET PRO 4 XR-640 C, SOLJET PRO 4 XR-640 WMT, SOLJET PRO 4 XR-640 LkW, SOLJET 

PRO 4 XR-640 LkMT, GS-24 

 STM Robotics: STM24, STM48, STM721, STM1351,  

 SUCHI: SC-730, SC-730E, SC-730S, YX-730L, SC-1300, YX-1300L, SC-1350E, SC-1350S, YX-24L, YX-

48L 

 Summa : F SERIES (SummaFlex) 

 Titan: TITAN 3 ARMS 


